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Huntron Workstation Access RF Software Tutorial 

Huntron Workstation software 

It is very helpful if you have a working knowledge of Microsoft Windows prior to using Huntron 

Workstation. 

You are allowed to create a backup copy of the software disk. Your purchase agreement allows for 

copies to be made for backup purposes only- copying for distribution or resale is strictly 

prohibited.  

 

Installation Instructions 

Install the software BEFORE connecting any hardware. Uninstall any previous versions prior to 

loading the current version. For more installation details follow the “Getting Started” sheet 

included with your Huntron product. 

Uninstall any previous versions of Workstation prior to installing the new version. 

Insert the Huntron Workstation DVD. The DVD should Autorun and begin the installation process. 

If your PC has Autorun disabled then browse Window and select WorkstationSetup.exe. This will 

begin the installation process. During the install you will be asked to install additional software for 

Access Probers. Select the appropriate response based on your Prober hardware. 

 

Installation of Additional Support Software 

Installation of software for the support of supported spectrum analyzers will be required for the 

proper operation and control. 

 

Keysight N9935A 

Insert the Keysight IO Libraries Suite CD or download the software from keysight.com. Run the IO 

Libraries Suite installer. The install process should begin. Use default selections as prompted 

during the installation process as there are no special conditions needed for the spectrum analyzer 

hardware. 

Copy the “HuntronExternal1.dll” file from the path “C:\Program Files\Huntron Workstation 

4.3\E1N9935A” to the path “C:\Program Files\Huntron Workstation 4.3”. Select “Yes” to overwrite 

the existing “HuntronExternal1.dll” file in that path. As an option, rename the existing 

“HuntronExternal1.dll” before pasting the N9935A “HuntronExternal1.dll” file. This will allow to go 

back to the default configuration if needed. 
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Rohde & Schwarz FSH4  

Install the support software provided with your model FSH4 spectrum analyzer. Interchangable 

Vitual Instrumentation (IVI) installations from other sources such as the Keysight IO Libraries 

Suite will also work with the FSH4. 

Follow the information provided in the “Quick Start” guide provided with your FSH4 to setup PC 

connection for the instrument. 

Copy the “HuntronExternal1.dll” file from the path “C:\Program Files\Huntron Workstation 

4.3\E1RSFHS4” to the path “C:\Program Files\Huntron Workstation 4.3”. Select “Yes” to overwrite 

the existing “HuntronExternal1.dll” file in that path. As an option, rename the existing 

“HuntronExternal1.dll” before pasting the RSFSH4 “HuntronExternal1.dll” file. This will allow to go 

back to the default configuration if needed 

 

Hardware Setup 

Connect the Huntron Access RF Prober to power.  

Connect the Huntron Access RF to the PC with the USB Cable. 

Connect the spectrum analyzer to power. 

Connect the spectrum analyzer to the PC using the Ethernet 

cable. 

Connect the supplied RF coax cable to the spectrum analyzer 

RF Input connector Port 2 (N9935A) or Port 1 (RSFSH4) using 

the supplied adapter. 

Connect the other end of the RF coax cable to the connector 

on the left rear panel of the Access RF prober. 

Using the “Access RF Getting Started” instructions, connect 

the spectrum analyzer to the Huntron Access RF by placing 

the RF probe into the probe holder mounted to the Z axis rail 

as shown in the image below. Connect the high frequency 

cable to the connection on the top of the RF probe. 
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Huntron Workstation Main Interface 

When starting Huntron Workstation for the first time, you will be prompted for an activation code. 

Type in the code exactly as it is presented on the installation DVD. 

Use upper case letters and note the differences between the letter “O” and the number zero. 

 

 

 

The Main Window for Huntron Workstation 4 features a multi-pane layout. The Panes are 

interactive to a certain degree in that changes in one Pane will affect other Panes. The Panes can 

be resized, floated independently (undocked) or “tabbed” to the sides of the window. The Status 

Bar displays information about items currently selected and status information while processes 

are running.  

  

Tree Pane 
- Test and editing 

Signature Pane 
(shown undocked) 
- Signature display 
and scanning 

Prober Pane 
- Robotic Prober 
control 

Image Pane 
- Display of CAD 

layout and PCB 

images 

Status bar 

Tool bars 
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The Toolbar 

The Toolbar just under the application menus allows for quick access to several program functions. 

The function of each is broken out in the diagram below. 

 

 

  1. 2. 3. 4. 5. 6. 7.  8.  9. 10.  11. 12. 13. 14. 15. 16. 17. 18. 19.  20. 21. 22. 

 

1. Create New Board database 13. Initialize Prober Home 

2. Open Board database 14. Connect/Disconnect Prober 

3.  Save As… 15. Clear Prober STOP condition 

4. Add New (Sequence, Component or Range) 16. Change Access DH/DH2 Probes 

5. Copy (Sequence, Component, Net or Range) 17. ON/OFF Access DH2 Interior Light 

6. Paste (Sequence, Component, Net or Range) 18. Connect/Disconnect Tracker 

7. Cut (Sequence, Component, Net or Range) 19. Previous Component or Net  

8. Delete (Seq., Comp., Net, Range or Scan) 20. Next Component or Net 

9. Build New (Sequence, Component) 21. Previous Pin 

10. Repeat New (Sequence, Component) 22. Next Pin 

11. Scan Component or Net 

12. Scan Sequence 

  



© Huntron, Inc 2020 Rev. B 7 

Hardware Setup 

Turn on the Huntron Access and the spectrum analyzer. 

When first starting Huntron Workstation, select Options from the Tools menu. The Options 

window is used to setup default settings used when working in Huntron Workstation.  

 

 

 

 

Select the General tab and set the desired Unit of Measure (use Microns for Huntron Access 

Probers, Mils for any other Prober). Also Select Compare Depth of Range. 

 

Select the Hardware tab and leave the type of Tracker hardware, the Tracker Port and Scanner 

options at none. 
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Select the type of Prober as Access RF, the serial port for the Prober as USB and the Frame 

Grabber type as DFK (Single). For older Access 2 Probers that use the HS20USB serial motor 

controller, select the COM port that is used by the controller. If you do not know the COM port, 

go to the Windows Device Manager. Locate the Ports settings as shown in the image below. Use 

the COM number shown next to “HS-20USB”.  

 

 

 



© Huntron, Inc 2020 Rev. B 9 

Check the Access (2) USB Grey Camera checkbox if your system is not using the DFK (Single) 

camera. 

Click the Connect button to initiate communication with the selected hardware.  

 

Select the tab that is available for your spectrum analyzer model (i.e. N9935A). Set the Host 

Name (IP) using the Static IP Address that was used when configuring the spectrum analyzer. 

Set Connection to “None”. Click the Connect button to connect with the spectrum analyzer. 

 

 

 

Select the Sequence tab, General tab and uncheck the Enable Tracker checkbox and check the 

Enable N9935A or Enable RSFSH4 checkbox depending on the model used. 
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Select the N9935A or RSFSH4 tab and configure the menus with your desired default settings. 

The Antenna setting corresponds with the probe type mounted on the Prober head. The 

Comparison setting can be set for Reference Waveform or Reference Power. 

 

 

 

Select the Range tab/General tab and check the boxes to enable only Range 1. Set the Range 1 

Tester to your model of spectrum analyzer and the Range 1 Delay to 0. 
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Select the N9935A or RSFSH4 tab under the Range Tab.  

You can set the plus and minus Tolerance amount, Maximum Signal in dB, Minimum Signal in dB, 

Start and Stop frequencies, auto attenuation and auto resolution bandwidth (RB). These steps are 

simply setting defaults for when you add new components to the test. You can change the values 

at any time by editing the Range for the Component in the Tree pane. 

 

 

 

Click the Save (Permanent) button to save this configuration as the startup default. 
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Using Workstation with an Spectrum Analyzer 

A spectrum analyzer based test will typically use the concept of Test Points (TP) or Virtual Test 

Points (VTP). The Workstation Software has, for programming purposes, the concept of 

components and pins. When using a spectrum analyzer it is best to think of components as tests 

and pins as Test Points (TP). 

 

Creating a Spectrum Analyzer Board Test 

There are a number of steps necessary to creating a spectrum analyzer board test.  

 

Huntron Workstation Test Layout (Tree)

Board (creates an Access .mdb file)

Sequence (test set of Tests) 

Component (Test)  (name, Functional Test)

Pins (TPs) (name; U1.6, TP3, etc.)

Ranges (Measurement settings)

 

 

Example of Board Test Information: 

Board Name: Sample (creates “Sample.hwdb” file) 

 Revision: (This field is optional) 

Sequence: 200Mhz Measurements  

Component (Test): Test Points 1-20 

Pins (TP): Per TP settings for X, Y, Z locations, etc… 

Ranges: Per TP measurement settings, tolerance, etc… 

The user has total discretion as to the information input into these fields. There is no “right” way 

as to what information is entered as every user’s situation will be different. The above example is 

just one way the information might be entered. 
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Entering information into the entry windows is very straightforward. The easiest way to move from 

field to field is by pressing the TAB key. You can also use the mouse to click into a particular field 

so you can enter information. 

 

Test Building Procedures 

- Determine TP Locations on the board and the tests to be performed 

- Create Test Database in the Tree Pane 

o Add Board, Sequence, and Components (Tests)  

If an Access Prober is being used: 

- Perform Camera Offset 

- Select Alignment points  

- Teach component pin (TP) 

Using the test: 

- Scan Sequences and Set References 

 

Listed above is a general outline on how you would proceed when preparing to test a board. As 

with any type of complex test equipment, practice makes perfect so take the time to learn and 

practice these procedures. 

 

Creating a Board Database 
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To create a new Board, select New from the File menu or use the New button in the toolbar. Input 

information into the “Add New Board” dialog as needed. The only field that is required is board 

Name (Example “Sample”). Other fields such as Revision, System, Unit, Manufacturer and Gold 

Disk Number can be completed with related information if desired. 

Adding a New Sequence 

 

 

To add a new Sequence, select the Sequence tab in the Tree pane. Select Add New Sequence 

from the Edit menu or click the Add New button (+) in the toolbar. 

Details: 

Sequence Name Field: Enter Sequence name 

Slot field: Select the Prober slot that the board will be in when scanning. 

Compare Priority: Selects the signature (or measurement) comparison priority between Same 

(serial number), All (serial numbers; this is the recommended setting) or Min/Max (Merged 

min/max signatures) 

The Delete Scans button will erase all scans for the current Sequence. 

Instructions field: Select the Instructions tab and enter any instructions or system 

information that you wish to pass on to future users. Note: the ENTER key in this field will work 

as a carriage return. 

For spectrum analyzer tests, select the Testers tab and check the Enable N9935A or Enable 

RSFSH4 checkbox. Uncheck Enable Tracker if it is checked. 
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Select the N9935A or RSFSH4 tab and make any needed changes to these settings. The default 

settings are configured in the Tools menu/Options/Sequence N9935A tab. 

 

 

 

Click OK to save the Sequence. Other functions within this window can be read by hovering your 

mouse over the item and viewing the Tool Tip or by clicking the HELP button. 

 

Adding a New Component (Test) 

 

 

To add a new Component (Test), select the Component tab in the Tree pane. Select Add New 

Component from the Edit menu or click Add New button (+) in the toolbar. 
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Details: 

Component Name field: Enter the component name (Test Name) in this field.  

Package and Number of Pins fields: Set the Package type as Probe. The Number of Pins 

should be set to at least the number of TPs in this Test (component). Select more pins than the 

current number of TPs allows more TPs to be added later. For unused pins (TPs) uncheck the Scan 

Pin check box on the Pin Tab after the Component is created. 

Type field: This information is optional but you can enter the component type in this field.  

Pin Spacing: Not used with spectrum analyzer tests. 

Connection Type: Set to Prober for Access RF Prober users 

Open Check Type: Not used by with spectrum analyzer tests 

Pause checkbox: Sequence tests will pause at this component and display instructions 

Test checkbox: Enables or disables testing of the selected component 

Correction Steps: Sets the maximum amount of correction steps used with the Huntron Access 

Prober when moving to the first TP of the Test. 

Instructions field: Enter any instructions or component information that you wish to pass on to 

future users. Rich text images can be pasted into this field. 

Other functions within this window can be read about by clicking the HELP button. 
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Pin Edit 

Settings for individual pins can be modified by open the Pin Edit window. You can open the Pin 

Edit window by selecting the Pin tab in the Tree pane, right-click the row header and select Edit 

Pin. 

 
 

 

Name: Type directly into the Name field to change the pin name 

Net Name: Type directly into the Name field to change the Net name 

Correction Steps: Modifies the number correction steps used with Access Probers. This may need 

to be modified for very small pitch devices. 

Scan Pin: Enables or disables scanning of the selected pin 

Pause: Prober will pause and display Pin Instructions before scanning 

 

Modifying a Range (Spectrum Analyzer Measurement Setup) 

When a new component (Test) is added to a Sequence default range(s) are added to each pin 

(TP). The defaults are set up in the Tools/Options/Range/(N9935A or RSFSH4) tab. These 

settings need to be modified based on signal being measured at each TP. The goal is to obtain a 

good measurement at each TP. To stop after a failure of a particular measurement it is best to use 

multiple Components (Tests) at the same XY coordinate each. The test only stops after a 

component (test) is completed. 
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To edit a Range, select the Range tab in the Tree pane. Select Edit Range from the Edit menu or 

the quick menu shown above. The Edit Range dialog will be displayed. The Tester drop menu 

shows the instrument used. 

 

 

Select the Tree/Range tab to 

display the ranges for the selected 

component pin. RIGHT click on 

the row header (far left grey area 

of the row) to display a quick 

menu (shown left) 
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Edit Range Details (settings may be different based on spectrum analyzer model): 

Note: All of the settings can be modified directly in the Range grid.  

+Tolerance: The amount above the Reference which determines the High Pass Limit. This 

amount is a value based on the number of deviant data points when comparing to the stored 

Reference measurement. 

-Tolerance: The amount below the Reference which determines the Low Pass Limit. This amount 

is a value based on the number of deviant data points when comparing to the stored Reference 

measurement. 

Max. Signal dB/Min. Signal dB: Sets the upper and lower limits of allowed dB change for each 

frequency 

Attenuation dB: Set the amount of attenuation for the instrument measurement 

Average (N9935A): Sets averaging the samples taken during measurement 

Detector (RSFSH4): Sets the detector type. RMS is recommended for cleaner waveforms. 

Samples: Sets the number of samples taken during measurement 

Start/Stop MHz: Sets the scanning frequency limits  

RBW Mhz: Set the resolution bandwidth for the measurement 

Floor dB: Sets the lowest level used for comparison (helpful with noise) 

SCPI: Used to send additional SCPI commands to the instrument. Refer to your instrument 

documentation. 

Auto At/Auto RB: Set auto mode for attenuation and resolution bandwidth 

Trigger: Enables the external trigger for the instrument 

+Slope: Enables trigger for positive slope; uncheck for trigger on negative slope 

Preamp: Enables the instrument preamp; recommended setting is checked 
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Mounting a PCB in an Access RF Prober 

Before software functions relating to an Access RF Prober can be performed, the PCB under test 

must be mounted into the Prober test area. Use the mounting accessories supplied with the Prober 

to securely mount your PCB by its edges. 

 

 

 

Refer to the Access RF Prober Users manual for more information on mounting a PCB. In some 

cases, a PCB holder is the best solution especially when the PCB cannot be easily mounted using 

the standard accessories. You will also need to consider cables and connections for getting the 

PCB to a power-on stimulated state. PCB holders are typically simple to construct and the only 

prerequisites are that the holder fit into the Prober and that it holds the PCB precisely at one of 

the designated Prober “Slots”. The Slots are referred to by the position in the Prober as TOP, 

MIDDLE, BOTTOM and BASE and are set in the Sequence Edit window (see section “Adding a 

New Sequence”). 
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Prober Setup – Camera Offset part 1  

 

 

Performing the Camera Offset procedure is essential for the Prober to access test points 

accurately.  

Select the Offset tab in the Prober pane. 

Navigate the Camera to a target on the PCB. A very small target that is still visible by eye works 

best. Use the arrow buttons to move the camera the distance set in the travel distance field 

(directly below the arrow buttons). You can also click directly in the camera image to move the 

camera crosshairs to the clicked location. 

When the target is selected, press Set. 

Select Prober in the Mode drop menu to move to the next step. 

 

Prober Setup – Camera Offset part 2 
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Lower the probe tip down using the Z buttons until the probe is as close as possible without 

contacting with the PCB. 

Visually examine the position of the probe tip; it should be located precisely above the target 

selected in part 1 of Camera Offset, if not move on to the next step. Use a video microscope or 

magnifying glass if necessary. 

Use the XY buttons to navigate the probe to the target selected in Part 1. The probe will lift when 

moving in the X or Y direction.  

When the probe is placed precisely over the target press the Set and Save buttons to calculate 

the Offset values. 

 

Prober setup – Alignment part 1 

 

 

Alignment points that are positioned in opposite corners of the board work best. If the test was 

created using CAD data, the alignment points are pre-selected and you should proceed as 

described below however be aware that the Save button will not become enabled. Refer to the 

CAD Import tutorial for details on Alignment when creating a test from CAD data. 

Select the Align tab in the Prober pane. 

Select Alignment 1 from the drop menu. 

Select and navigate the camera to the first alignment point. Fiducial marks, small vias or traces 

with 90 degree bends work well for alignment points. 

When the camera is set on the first alignment point press Set. 

The alignment point drop menu will select Alignment 2 automatically. 
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Prober setup – Alignment part 2 

 

 

Make sure Alignment 2 is selected in the Alignment point drop field. 

Select and navigate the camera to the second alignment point. 

When the camera is set on the second alignment, press the Set button. 

 

The Auto Align feature will use image recognition to find and automatically center on the 

alignment point. Auto Align will only work after Align is performed manually the first time. 

 

Press the Save button to store the alignment points and the alignment point images. 
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Creating a Board Image 

 

 

For Prober users, the built-in color camera can be used to create a “mosaic” of the PCB by 

capturing images of the board and stitching them together. This is accomplished in the 

Image/Image Pane. The board must first be aligned before creating the image. Once aligned, you 

can use any camera view in the Prober pane to set the borders for image capture.  

Move the camera to the back right corner of the board. 

Press the Set Back Right button in the Image/Image Pane. 

Move the camera to the front left corner of the board. 

Press the Set Front Left button in the Image/Image Pane. 

Press the Create Image button to create the board image. 

 

Larger boards will require more time to create the board image. Once the board image is created, 

you can click a point on the board image and the Prober will move the camera to that point. 

Right-click on the image to display a menu to Delete, Copy or Save As the board image. 

Also, you can enable Update Image Pane Cursor (Tools menu/Options/Prober tab) to show 

the current camera position on the Board image. The position is shown as a transparent grey box 

with red crosshairs. 
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Prober setup – TP Teach – XY Setup  

 

 

Select the Teach tab in the Prober pane. 

Select the component to teach the Tree/Component pane. 

Select 1 in the Pin drop menu. 

Navigate the camera to the location of the first TP (Pin 1) (see image above). 

When the camera is set on the first TP, press the Save button. The Pin drop menu will increment 

to the next pin. 

 

Navigate the camera to the Location of the 2nd TP. 

When the camera is set on the 2nd TP, press the Save button. 

 

Continue setting the XY locations of all the TPs. 
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Prober setup – TP Component Teach Height (Z) 

 

Select the Teach Height tab in the Prober Pane. 

Select a Pin number in the Pin Z Down drop menu. This will position the probe tip at the selected 

TP. 

Use the Z Move buttons to lower the Z axis probe to the desired Sequence Up level. Make sure 

this level is high enough to clear tall components and chassis walls. This is the position the probe 

will lift to while probing the pins of all components in the Sequence. 

Press the Save button in the Sequence Z Up section to set the Sequence Up position. 

 

If desired, you can set an additional Up level for the selected component. This is the level that the 

probe will lift to when moving from one pin to the next. Use the Z Move buttons to move the 

probe down to the desired Component Up level. Make sure this level is high enough to clear the 

component package. Press the Save button in the Component Z Up section to set the Component 

Z Up position.  

 

The next step is to set the probe down position.  

Use the Z Move buttons to lower the probe to the position used when the measurement will be 

taken. You may want to lower the probe in small increments when working close to the PCB 

surface. Do this by changing the Z Travel distance setting. 

Press the Save button in the Sequence Z Down section to set the Sequence Down level. This is 

the level the Prober will use when probing the component pins. 

If needed, you can also set Component Z Down and Pin Z Down levels for individual 

components and pins.  If the TPs of the component have varied heights, then use the Pin Z Down 
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settings to modify the height position for each individual pin. Select the pin in the Pin drop menu, 

position the probe to the desired height and click the Save button in the Pin Z Down section.  

 

Manual Modes 

 

 

Manual measurements can be obtained using the N9935A or RSFSH4 tab in the Signature pane. 

This pane may be useful when configuring test parameters for a Test Point (TP). Setup the 

Measurement parameters and click Get Reading to capture and display a numeric Power 

measurement. Click Get Wave to capture and display the spectrum analyzer waveform. Click 

Hold Reading or Hold Wave to keep the reading or waveform displayed while capturing and 

displaying a second measurement. Use the From Range button to set the range parameters to 

the same setting as the selected Component. Use the Set Range button to set the ranges for the 

selected Component/Range using the displayed parameters. Reading RT/Waveform RT 

(RealTime) will enable a constant refresh of the waveform or reading. 
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Scanning a Sequence or Component 

 

 

Select the Sequence or Component to be scanned in the Tree Pane. 

Select the Scan tab in the Signature Pane (shown above). 

Input a Serial Number into the Serial Number field; this will be the name of the scan. 

The Stop On Failure check box will cause the scanning to stop if a component comparison fails. 

This is most useful when scanning known good boards to add as references. 

The Scan Continuous check box will cause the scan to go into a loop mode where it will scan 

without stopping until a signature comparison fails. 

Enable the Sequence checkbox to scan all of the components in the Sequence. 

The Use Scan List check box will add the ability to use a Scan List when the Scan Sequence 

dialog appears (see Creating a Scan List section). 

Press the Start button to execute the scan. 

The test instructions prompt will be displayed. Clicking OK will start the scan for probers. 

When a scan is complete, the results NO REF (No Reference), PASSED or FAILED will be 

displayed (the text of the results message can be changed in the Tools/Options/General 

settings). The NO REF message will be displayed on the first scan of any test since there are no 

scans stored as Reference. 

Clicking the Troublesheet button will display the waveform differences in the Troublesheet tab of 

the Signature pane. 
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Viewing Signatures – Troublesheet 

To view the test results, press the Troublesheet button in the Scan Results window. 

 

 

 

The current measurement, the measurement type, nominal value, tolerances, deviation and test 

result will be displayed in the signature box. 

If this is the first scan then clicking the Set Reference button will mark the current scanned 

waveforms as the known good scan for comparison. 

When a scan is executed signatures are compared against the Reference set (or sets) if it exists. 

To add the signatures in the Troublesheet as a Reference, press the Set Reference button (do 

this only with known good measurements). Signatures of the compared (Reference) signatures 

are displayed in contrasting colors. By default, the Reference signature is green and the failed 

signature is red.  
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The Deviation (Dev) shown in the signature box is the amount that the measured value deviates 

from the Reference value plus the tolerances set for the range.  

Right-click the signature box to display the functions menu. 

 

 

 

Most of the items on the menu are shortcuts to functions such as Sync Pin/Range, Teach Pin, 

Teach Height Pin. One of the most useful is Reprobe Pin Signatures which will rescan the 

selected pin and prompt to replace the previous scan with the new scan. See the Viewing 

Signatures – Right Click section below for more details on this menu. 

 

  



© Huntron, Inc 2020 Rev. B 31 

If Set Reference is used, run the Scan again. A PASSED result should be indicated.  

 

 

Click the Troublesheet button to view the results. The Reference and Passed measurements will be 

displayed as well as the Deviation (Dev.) between the two. 
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Viewing Signatures Troublesheet Report 

To view and print the Troublesheet report, press the Print button in the Troublesheet window. You 

can select from several options including a Sequence or Component Level report, the level of 

detail and add problem and solution comments to the report. Click Preview to view the report on-

scree 

 

    

 

 

The report can be printed or exported in several different formats including HTML and PDF by 

selecting File/Export Document in the Preview window. 
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Viewing Waveforms in the Signatures Pane 

 

 

To view scanned waveforms, select the Signatures tab in the Signature Pane. Signatures marked 

with an asterisk * indicate that this scan is set as a Reference. The Scan name, date and time will 

be displayed on the left side of the window and waveforms on the right. The Scale buttons will 

change the number of columns displayed. Scaling the window will increase the number of 

waveforms displayed. The Copy button will copy the waveforms to the Windows clipboard so they 

can be pasted into another program (in a metafile format). The Print button will print the 

waveforms in one of several different user selected formats. 

 

Viewing Signatures – Right Click 
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Additional options when viewing signatures can be displayed by right clicking in the signature 

area. 

Reprobe Pin Signatures: Gets new signatures and prompts to replace the previous ones. If this 

option is performed with a Reference scan selected from the list on the left (marked by *), then 

you can replace the Reference signature. This is helpful if you had set an incorrect 

measurement as a Reference and want to replace it. 

Real Time: Updates measurement in real time 

Get Signature: Capture signature 

Replace Signature: Replaces the stored signature with the current signature displayed for the 

selected pin, range and scan (shown in the Scan List to the left) 

Replace Pin Signatures: Replaces the stored signatures with the current signatures displayed 

for the selected pin, all ranges and scan – works only in Range Mode 

Sync Pin/Range: Selects pin and range in the Tree (see default in Tools/Options) 

Edit Range: Selects the pin and range in the Tree and opens the Edit Range dialog 

Disable Range: Disables the selected range for the selected Pin  

Edit Pin: Selects the Pin the in the Tree and opens the Edit Pin dialog 

Edit Comp/Net: Opens the edit window for the selected Component or Net 

Teach Pin: Selects the pin the Prober Teach pane 

Teach Height Pin: Selects the pin the Prober Teach Height pane 

Group Edit: Opens Group Edit dialog for editing of component pin parameters as a group 

Net Edit: Opens Net Edit dialog for editing of Net pin parameters as a group 

Sync CAD: Will link the selected signature to the CAD image displayed in the Image/CAD pane. 

Sync CAD will be disabled if there is no linked CAD data. 

Copy: Copies the selected waveform to the Windows clipboard 

Data: Displays the numeric data for the selected measurement 

Range/Pin Mode: Displays signature with Range priority or Pin priority; see default in 

Tools/Options). 
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Component Scans Information 

 

 

Selecting the Component Scans tab in the Tree Pane will display all of the scans performed on 

the selected component in a table format. The Scan information displayed includes the serial 

number, operator, date/time, Merge setting (checked if this scan is included in the Merge set), 

Reference setting (checked indicates it is set as a comparison Reference), Pass status (will be 

checked if components passed comparison), Removed status (will be checked if component was 

removed from Troublesheet), Area number (highest of scanned pins), Deviation, Min/Max status 

and other settings (see Help for more information). 

 

Component Scans – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Row bar of the Component Scans pane displays an additional menu for 

performing specific tasks such as deleting a scan for the selected components or all components. 

Enable Sequence Reference/Disable Sequence Reference will mark or unmark the selected 

scan as a Reference (comparison) scan for all components in the Sequence. Delete Scan will 

erase the selected scan for the current component only. Delete Scan All Components/Nets will 
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erase the selected scan for all components or nets in the Sequence. Load Troublesheet will 

display the selected scan in the Signature pane/Troublesheet tab. 

 

Component Scans – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Column bar of the Component Scans pane displays an additional menu for 

performing specific tasks such as sorting or globally setting parameters. The menu will vary 

depending on the column selected. In the image above, the Reference column header was right-

clicked. 

 

Component Scans – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Column bar of the Component Scans pane displays an additional menu for 

performing specific tasks such as sorting or globally updating items. In the image above, the 

Serial Number column header was right-clicked.  
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Range Tab – Right-click Menu 

One very useful feature making quick global changes to range parameters is the menu available 

by right-clicking the column header (the title area directly above the column) in the Range tab. 

 

 

After making a parameter change for the range, right-click the column header for that parameter 

as shown in the image above to display the menu. The most useful selection is Set Current 

All/Pins where all of the pins of the component will be modified to the same setting as the 

selected Pin. This menu is available for most Range parameters. Remember to make the 

parameter change first then use Set Current All/Pins.  

 

Sequence/Component/Pin Editing – Right Click menus  

 

Right clicking on the Row header bar of the Tree pane displays an additional menu for performing 

specific tasks such as Add New, Insert, Delete, Repeat, Build (repeat but with name 

incremented by 1), Copy, Paste and Cut. Right clicking works at all levels of the Tree pane 

including Sequence, Component (shown above), Pins, Ranges and Scans. The Sync CAD option 
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available at the Component and Pin levels will synchronize the selected component or pin to the 

CAD tab in the Image pane. 

It is also possible to select groups of components by holding the SHIFT or CTRL keys while 

selecting components in the Tree. To copy, paste, cut or delete groups of components, use the 

Copy, Paste, Cut or Delete Toolbar buttons below the main menu.  

 

 

Select Group Edit to open the Group Edit window for the selected Component. This allows you to 

duplicate changes made to the selected Component to other Components in the Tree.  

Note: Be sure to make your changes to the selected Component before using Group Edit to 

duplicate the settings to other Components. 

 

 

To use the Component Group Edit, select the Components on the left that you wish to change. You 

can SHIFT and CTRL keys to select groups or individual Components in the list. Mark the setting 

you want to change by clicking the checkbox. The example above shows the Component Z UP as 

the setting to change. Click Process to make the changes to the selected Components. 
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Pin Editing – Right Clicking (Auxiliary menus) 

 

 

Right clicking on the Row header bar of the Tree/Pins pane allows for editing of the pin 

information. Select Edit to open the Edit window for the selected pin. 

Note: Some Pin settings can also be edited directly in the Pins grid by clicking the appropriate field 

and modifying the setting.  

Group Edit and Net Edit allow you make changes to the pin of a component and have those 

modifications also change components that have the same number of pins within the same 

Sequence.  

 

 

  

Change the desired settings for 

the current Pin first then select 

Group Edit from the right-click 

menu (see above). Components 

with the same number of pins will 

be listed. Select the components 

and pins you want to be changed. 

Select the Pin Settings check 

box(s) for the setting(s) you want 

changed. Check the Ranges box 

to match the ranges (this will 

cause signatures to be deleted). 

Click the Update Pins/Ranges 

button to make the changes. 



© Huntron, Inc 2020 Rev. B 40 

Huntron Workstation Buttons Feature 

Huntron Workstation has a built-in feature that allows any Windows based program to be started 

by clicking a button in the Workstation toolbar. It is very easy to use and a “Button” can be 

attached to any Board, Sequence or Component/Net. In this example, a Button will be created for 

a Sequence but the process is the same for the Board and Component/Net levels. 

To start, the Sequence edit window is opened by right-clicking the row header for the desired 

sequence. The Edit window will be displayed (see below). 

 

  

 

Select the Buttons… button located on the right side of the Sequence Edit window to open the 

Buttons Setup window. 

 



© Huntron, Inc 2020 Rev. B 41 

 

 

To configure the Button, a Caption (button name displayed in the Tools menu), Command Line 

(the application to be run) and File Path (the file opened by the executed application) need to be 

input into the corresponding fields. A File path will not always be required such as instances where 

a browser is started and pointed to a specific URL. In this example, the button will be configured 

to start the Microsoft Paint application and open a small PCB image (see image below). If desired, 

the icon displayed in the main window toolbar can be set by browsing to and setting a path to an 

.ICO (icon) file in the Icon File Path field. Add text that will be displayed when the cursor is 

placed over the Button in Tooltip field. To make the linked file or icon stored as part of the Board 

database, check the Store File and/or Store Icon checkboxes. 
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Click OK to accept the Button. To create additional Buttons, repeat this process and click the Add 

New button in the Button Setup window. 

When Buttons are created, an additional toolbar button will appear below the Huntron Workstation 

menu. This toolbar button will change according to the level (board, sequence or component/net) 

selected. 

 

 

 

The icon shown can be replaced by selecting an appropriate icon in the Button Setup window (the 

default icon is shown). Click the toolbar button to execute the Button.  

 

Technical Support 

For questions or assistance in using Huntron Workstation, contact Huntron at  

800-426-9265, 425-743-3171 or email info@huntron.com. There is online assistance for Huntron 

Workstation at www.huntron.com/sales-support/software.htm. This page will contains software 

updates and updates to documentation such as this tutorial. 

  

mailto:info@huntron.com
http://www.huntron.com/sales-support/software.htm
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Appendix 1: Using the Set Size Feature for Access Probers 

 

The Set Size feature allows the user to make adjustments to the dimensions (units of measure per 

pixel) of the image used in the Offset, Align, Teach and Realign windows. This is useful to adjust 

accuracy when clicking in the image to move to a point and to create better stitching of the image 

used in the Image pane/Image tab. 

The Set Size feature is available by clicking the Set Size button in the Prober pane/Offset tab. 

The dimensions shown in the Set Size window when opening it for the first time will be factory 

default values. 

The basic rules making adjustments in the Set Size window are: 

- When clicking on a point in the camera image and the camera moves too far – decrease 

the Horizontal Length and Vertical Height values 

- When clicking on a point in the camera image and the camera moves too short – increase 

the Horizontal Length and Vertical Height values 

 

Use the following example to help learn the process of calculating and adjusting the values. In this 

example we will be adjusting for a camera that moves too short. Before starting, make sure 

the circuit board is mounted at the Slot level set for the selected Sequence. The board 

cannot be above or below the selected Slot level. 

Place the camera crosshairs on a point on the circuit board. Next, click on a point at the extreme 

left or right edge of the image, in this case, the left side was used. 

 

Clicked location 
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Notice that the camera crosshairs did not go to the clicked location but fell short. 

 

 

To measure the distance from the crosshairs to the clicked location, move the mouse cursor 

(crosshairs) to the clicked location but do not click. The distance between the camera crosshairs 

location and the clicked location will be shown on the Mouse X field of the Offset window (red 

box). Write this value down. 

 

 

Clicked location 

Clicked location 
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The next step is to calculate the vertical distance. Put the camera crosshairs on a point on the 

circuit board. Click a location on the extreme top or bottom edge of the camera image. In this 

example, the top edge was used. 

 

 

 

Notice that the camera crosshairs did not go to the clicked location but fell short. 

 

 

Clicked location 

Clicked location 
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As you did with the horizontal distance, you will need to measure the distance from the camera 

crosshairs to the clicked location by moving the mouse crosshairs to the clicked location. 

 

 

Move the mouse cursor (crosshairs) to the clicked location but do not click. The distance between 

the camera crosshairs location and the clicked location will be shown on the Mouse Y field of the 

Offset window (red box). Write this value down. 

 

Click the Set Size button and you will see this window displayed. The values shown will be the 

factory default unless they were changed previously. 

 

 

Using the X measurement you wrote down earlier, multiply this distance X2 and add the result 

to the Horizontal Length value. Next, multiply the Y measurement written down earlier X2 and 

add the result to the Vertical Height value. It is necessary to multiply by 2 because the 

dimension needs to be corrected in two directions, top edge to bottom edge and left edge and 

right edge. The image below shows that values with the measured corrections made. 

Clicked location 
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Click OK to save the changes and try clicking in the camera image. You will find that the accuracy 

is much better. You may need to make additional small adjustments to achieve satisfactory 

accuracy. If you have a board image already created in the  

Image pane/Image tab, you will want to recreate the image again. The result should be better 

stitching at the image tile seams and an overall better image. 
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Appendix 2: Huntron Workstation Archive Scans Feature 

The new Archive feature built into Huntron Workstation allows you store and remove Sequence 

scans from the working database to achieve better performance. These archived scans are not 

deleted but saved away in a different database table and can be restored at any time. It is very 

simple to use. 

 

 

- Select "Archive Board Non-Reference Scans" from the Workstation Edit menu 

- At this point the software will search the database for non-reference scans that were part of a 

Sequence scan and remove them from the active database 

- If you look at the Components Scans tab in the Tree pane, you will see that the Reference scans 

remain 

- To unarchive a scan, select "UnArchive / Delete Board Non-Reference Scans" 

- The Sequence Scan Archive window will be displayed 
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- You will see the Archive Scans listed where you can select the scan you want to restore to your 

test Sequence. Use the CRTL or Shift keys to select multiple scans if needed 

- Click the UnArchive button and the selected scans will be restored to the Sequence 

- Use the Delete button to permanently delete scans that are no longer needed. 

- Close the Sequence Scan Archive window and look at your Component Scans tab and you will 

see that your scans have been restored. 

Keeping your test database small is the best way to get the most out Huntron Workstation 

performance. 
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Appendix 3: Manually Placing Component Tags in the Image Pane/Image 

tab 

Tracker users will appreciate this feature which allows you to manually place tags with the 

Component name in the board overview image in the Image pane. 

You will first need to get a high quality image of your PCB then select the Sequence where you 

want to use the image. Select Edit Sequence (Ctrl+E) from the Edit menu. Select the Top 

Image tab or Bottom Image tab depending on the Side setting used above (red arrow). Click 

the Load… button and browse to select and Open your image. 

 

 

 

The image should now be displayed in the Top (or Bottom) Image tab. Click OK to close the Edit 

Sequence window. 

The image you loaded should now be showing the Image pane/Image tab. If you do not see the 

Image pane go to the Window menu and select Image Pane. You may need to adjust your 

Workstation layout by click-dragging the panes by the title bar to get the arrangement that suits 

your needs. 
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To place a Component name tag in the image, select the Component in the Tree pane/Component 

tab then right-click at the component’s location in the image. It is best to click slightly left of 

center as the text will be left justified. Select Set Component Position from the popup menu to 

place the tag. You should see a grey name tag appear. 

 

 

 

It is recommended you add all of the tags before running any scans.  

The radio buttons on the left side (red box) control what is displayed in the image. None disables 

the tags, Current displays the tag of Components in the current Troublesheet (green tags for 

Passed and red tags for Failed) and Comps displays all tags in grey.  
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You can have the tags appear during scanning by selecting the Tools menu/Options/Scan tab 

and enabling Show Components on Image. As you run your test, a green (Passed) or red 

(Failed) tag will appear on the component in the image to indicate its test status. This works the 

same with Prober systems as well. 

 

 

 


